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PART I

Microsoft 365
Features

The Microsoft 365 applications share a common look and feel. You can find
many of the same features in each program, such as the Ribbon, program
window controls, and the File tab. Many of the tasks you perform, such

as creating and working with files, share the same processes and features
throughout the Microsoft 365 suite. In this part, you learn how to navigate
the common Microsoft 365 features and basic tasks.

2

L Search for apps, files, templates and more

> O

x
3

Welcome to Microsoft 365
& 64.7 GB used of 1 TB (6%)

J Install apps

B

Create New

i®
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o
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Word PowerPoint Excel orms orms Lists

See more in Create =

~ Discover what you can do
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Start and Exit Microsoft 365 Apps

Microsoft 365 installation creates an icon for each Microsoft 365 app either on the Start menu or
in the All Apps list. To work with an app, you need to know how to launch the app on your PC.
When you are finished with an app, you also need to know how to exit the app.

This section uses Word to demonstrate how to open an app from Windows 11. Once a Microsoft 365
app opens, its Start screen appears, where you can find a recent document or start a new document.
Other ways to open or create a document are covered later in this chapter.

Start and Exit Microsoft 365 Apps

@ Click Start (53).

Q Search fi i d t:
The Start menu appears.
Pinned Allapps > *’
O Alternatively, you can click Search (Q), type the &b’ s "
name of the app, and then click the app in the D R
(Office)
search results. B B d @ o
. . Mieroseft Store Photos. Xbox Solitsire & Spotify Paint
o Click the Microsoft 365 app you want to start. e
. . = B 8 % =
Note: If the Microsoft 365 app you want is not on the Mk LRSS T i
main Start menu, continue with step 3. L
€ Click Al apps. 2 e [T it
@ :::e:;ﬂ:l«ing IE :-ele;?rcwerence

Windows displays the ALl Apps list.
e Click the app you want to open.

All apps < Back

T

B erminal

w

& weather

£y  Windows Backup
System

Windows Security

System

Windows Tools

System

Word

o

Xbox.

PR R @

Xbox Cansole Companion

@wu 0]




MICROSOFT 365 FEATURES C”Ajr“

Microsoft 365 Basics

The app launches and displays & o &Q e e
its Start screen. i
() Home Good morning
(© You can use the Home panel to B New - 2
start a blank document or open B Open
a recent document. e
@ You can use the New panel to - -
Blank document Welcome to Word Insert your first table of cont...
start a new document.
More templates —
(© You can use the Open panel to 5 -
. . Search
open an existing document.
Recent Pinned Shared with Me
@ This area indicates whether you r
Mame Date modified

have signed in to your Microsoft

CopilotAnswers-20240926-134524 Thu at 1:45 PM

365 subscription. P Paui M Onebive
. s Agenga for 2023 Industry Conference G
Note: Refer to Chapter 3 for details PE el DT g
about signing in to Microsoft 365.
@ Avoswe @or) B 9 1) = Documentl - Ward o iy O %
o TO eXit the app, Cljck the close File ~ Home Insert Draw Design Layout References Mailings Review View Help | 2 comments | \Z|

button (X). = — VN I A

pasie [0 BT Lok xR ! Styles | Editing  Dictate | Editor  Add-ins
. v v £« A orar AKX v - M
Note: If you have multiple documents N o0 "

open, you must click Close (3<) for
each file to exit the app.

I Styles [ Voice Editor | Add-ins ~

TIP Pagelof1 Owords Text Predictions: On 0 Accessibility: Good to go I Focus B e=——~1——= 1
Can I create a shortcut to open a § ~

Microsoft 365 application? e &9 i

Yes, you can pin the app to the Windows Start : mﬂ&”“ &9 he
menu or taskbar. Follow steps 1 to 4 in this apEel U it T Fccc i
section, and then right-click the app name in & gt Speal Jlowton

the ALl Apps list. From the menu that appears,

click Pin to Start (A) to add the app to the Pinned section of the Start menu; or, click More (B) and then
click Pin to taskbar (C) to pin the app to the Windows taskbar. To open the app, click the app’s tile in the
Pinned section of the Start menu or the app’s button on the taskbar.




Explore the App Window

(L Microsoft 365 apps share a common appearance and many of the same features, and when you
learn the features of one Microsoft 365 app window, you can use the same skills to navigate
the windows of the other Microsoft 365 apps. These common features include the title bar, program
window controls, zoom controls, and the Ribbon. The Ribbon is an important Microsoft 365 feature
because it contains the app commands and features that you will use most often. You will learn more
about the Ribbon later in this chapter.

P search

O Title Bar

Displays the name of the open
file, the name of the Microsoft
365 app, and the AutoSave and ‘

Save bUttons' 5 A = B f D E F G H | ) K L M N v‘

—1
O Search

Enables you to search for items
within the app.
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Displays your Microsoft 365
sign-in status. If your name

1
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15

Sheetl @
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P Ready 7 Accessibility: Good to go

r e

¥ »
e ] 0 - ————+ oo

7 e )

appears, you are signed in to
your Microsoft 365 subscription. You can click your avatar to display a menu that enables you to manage
your Microsoft account settings or switch to a different Microsoft account. If you are not signed in, this
area shows a Sign In link.

@ Program Window Controls

Enable you to control the appearance of the app window. You can minimize the Ribbon, and you can
minimize, maximize, restore, or close the app window.

@ Zoom Controls
Change the magnification of a document.

@ View Shortcuts
Switch to a different view of your document.

O Status Bar
Displays information about the current Microsoft 365 document.

O Ribbon

Displays groups of related commands in tabs. Each tab offers buttons for performing common tasks.




CHAPTER

Work with Backstage View 1

You can click the File tab to display Backstage view. In Backstage view, you find a list of actions that
you can use to open, save, print, remove sensitive information; distribute documents; and modify
the app’s settings. You can also use Backstage view to manage the places on your computer hard drive
or in your network that you use to store documents and to manage your Microsoft 365 account.

Work with Backstage View

@ Click the File tab to display

@ Autose @ o) B/ 9 - ¥ Bookd - P search e = @ ®
BaCkStage view. Fle Home Insert Draw Pagelayout Formulas Data Review View Help [= comments |
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12
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19 v
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’@ Recent ‘ ‘ L Search
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. Q : Workbooks
R Shared with Me
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. Get Add-ins et Pinned
o Informat]on related to the . -~ S::K’Dh;:‘a';w:it’;i" ;’i,r;lz\esyouwamlueasilyﬁr\dla\er,(lr:kthepmi(unIhalappealswhgnyouhuuwu
button you click appears here. i . Older
. . paulmctedries@hotmail.com I
E;\ch. t;me you Chf]k a buttor:l, = — SaesbyDivion w2466
the information shown to the B merc sz s
right changes. Shore o
@ Add a Place Temperatures W16/24 12408
bq)c Paul M's OneDrive » Documents = W...
Note: The Home, New, Close, and : B mu ,
. . Close Stock Price 8/16/202412:37 P
Options commands do not display LD ol il
buttons or information; rather, Account i
. ‘ B2 Recover Unsaved Workbooks
they take other actions. Optrs
4 »

© Click the Back button (©) to
return to the open document.



Change the Color Scheme

You can use Microsoft 365 themes and background patterns to change the appearance of the
screen for every app. Themes control the color scheme the apps use, and background patterns
can add interest to Backstage view. Color schemes can improve the look of each app’s screen,
but be aware that some schemes might be distracting.

Microsoft 365 themes are available even if you are not signed in to Microsoft 365, but to use
background patterns, you must sign in to Microsoft 365. For details on how to sign in and out
of Microsoft 365, refer to Chapter 3.

Change the Color Scheme

Note: Make sure you are signed in to @ osme @0 H 9 O = vmcument - Word p (O ® = @ =
Microsoft 365. Refer to Chapter 3 for details.
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€ Click the Office Theme ™. T
. ® al
o Click a theme. T
o) Hora User Information Product Information
The colors of your app change. B e v~ B¥ Microsoft
= Ope Sign out AL
Note: Some theme changes are more de L el
subtle than others. Account Privacy Microsoft 365
(8] 6etAdd-ins |w This product contains

© Click the Office Background .

Info

Save

Office Background:

Jddocadaw

| Ne Background

| Manege Account | | Switch License | | Update License

Offce Teme | | Microsoft 365 and Offi
s ICroso! an ce
G [ white [:rbl?ﬂ Upd.
Update Updates are automatically dovnloaded
Print Options ~ and installed.
Use system settin P—
Bpat s i Microsoft 365 Insider
e B e Jein the Microsoft 365 Insider program
Transform Microsoft 365 | and get early access to new releases of
Insider ~ Microsoft 365 apps.
Close
About Word
.; @ Leam more about Word, Support
SRR Product ID, and Copyright informaticn.
AboutWord | version 2400 (Build 18025.20104 Click-to-
Options Run)

Current Channel

e Click the pattern you want to use, o oyl
Or ch'ck No Background. User Information Pmductlnlo.rmation
S o B¥ Microsoft
3 E Open
o As you po1 nt the mouse (%) ata i’ &4 lﬁmm Subscription Product for
: : Share oy apea logophilia@outiook.com
choice in the menu, a background Ty e
pattern appears at the top of the e st [ Moneg st | e —
. d Th l_ o Office Background: ddAEdAII
window. e pattern appears on y | No Background ”J@ Manage Account \smmu:sﬂ Upmemns;
N . N e No Background
in Backstage view; it does not ‘ g_a‘.i‘wf..:m_ | M mons
g L @
appear as you work on gt e [
documents. St Doodle Circles Sipere s i
Bport P Microsoft 365 Insider
. L pas Join the Microsoft 365 Insider program
@ Click the Back button (@) to e | R
i
Close -
return to your document. = o | e
. e T e
The Microsoft 365 theme you ar P | o o 05 200
Current Channe|

selected appears.

What happens if I select a background and then sign out of Microsoft 365?

The background no longer appears in the app but will reappear when you next sign in to Microsoft 365.
Similarly, theme changes you make while signed in to Microsoft 365 might disappear when you sign out
of Microsoft 365. With themes, however, you do not need to be signed in to Microsoft 365 to make a
selection. Just complete steps 1 to 4 in this section.




Work with the Ribbon

You use the Ribbon to access an app’s commands. The Ribbon is divided into tabs, the names of which
vary depending on the app. Excel’s Ribbon, for example, includes tabs named Home, Insert, Formulas,
and Data. Each Ribbon tab is divided into groups of related commands. The Home tab includes the
Clipboard group for copying and pasting data and the Font group for applying text formatting.

Each Ribbon command does one of four things: run a task, display a menu of commands, display a
gallery, or launch a dialog box.

Work with the Ribbon

Run a Command @ autosave @D B2 9 - - S First Quarter Sales - Excel - Saved v P
o CliCk the tab Conta]n1ng the command Home Insert Draw Page layout Formulas Data Review View Help
you want to use. ﬁj X |W:\|E| = % [ Conditional Formatting ~ @
. Pacte LB B% AN = Number | BB Format a5 Table ~ Cells
o Click the command. © F Ee de A = BB el stytes ~ -
Clipboard Y Font = Alignment 1] Styles
The app runs the command‘ Al Y v ﬁc First Quarter Sales (in Thousands)
A | B C D E [F G H
1 |First Quan|er Sales (in Thousands)
2
3 January  February March
4 Doohickeys 149 155 168
5 |Gizmos 212 242 255
6 Thingamajigs 310 322 343
7 Widgets 275 260 270
8
9
10
1
Run a Command from a Menu @ sutoswe @D B 9 @ S First Quarter Sales - Excel - Saved v £
o Cl-iCk the tab Containing the menu you Home Insert Draw Page Layout Formulas Data Review View Help
Want tO use. f‘lj |AptosNarrow V”E' = = % [E]l Conditional Formatting ~ @
. 2 B I U-AAN === Mumber | A Format as Table ~ Cells
() Many Ribbon buttons have two parts: o & A == % © [ el styles~ -
the top part runs the standard command, B et S e
and the bottom part displays the menu. (b [k B ,‘e 3
. EE [&Iﬁ E’ Keep Snur( Formatting (K] L E LE g H
e Click the button’s arrow (). 1/ paste Values ale ds)
.. 28 B, B
A menu of additional commands 3 e ;i.j:.,.- uary February March
4| DT Teste Uptions 149 155 168
appears. 5| [ @de | 212 242 255
o 6| PasteSpecial.. 310 322 343
() Position the mouse (I+) over a AW 175 o 70
command to display a tooltip that 8
displays the command’s name. &
10
9 Click the command you want to run. .

10



Choose an Item from a Gallery
o Click the tab containing the gallery
you want to display.
Q Click the gallery’s More button ().
e Click the gallery item you want
to apply.

(® When you position the mouse ([})
over a gallery item, the app displays
a preview of the effect.

Launch a Dialog Box

0 Click the tab containing the group
you want to work with.

o Click the group’s dialog box
launcher (Iw).

() The app displays a dialog box
containing additional settings
related to the group.
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need them.

Why do some Ribbon tabs appear and disappear?
Tabs that come and go on the Ribbon are known as contextual tabs.

They are contextual in the sense that they appear only when you select
an object in a document. For example, if you select a chart in Excel, the
Chart Design and Format tabs appear. These contextual tabs contain
commands related to working with charts. When you click outside the
chart to deselect it, the contextual tabs disappear because you no longer

Can I make the Ribbon take
up less room?

Yes. Right-click any section of
the Ribbon and then click
Collapse the Ribbon. Now just
the Ribbon tabs appear. You
can display the full Ribbon
temporarily by clicking a tab.
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Select Data

You can select data in your file to perform different tasks, such as deleting it, changing its font
or alignment, applying a border around it, or copying and pasting it. Selected data appears

highlighted.

Depending on the app you are using, Microsoft 365 offers several different techniques for selecting
data. For example, in Word, PowerPoint, Outlook, and Publisher, you can select a single character,
a word, a sentence, a paragraph, or all the data in the file. In Excel and Access tables, you typically
select cells. In OneNote, use the technique appropriate to the type of data you want to select.

Select Data

Select Data in Word, PowerPoint,
or Publisher

Note: You can use this technique to select
characters, words, sentences, and paragraphs.

Click to one side of the word or character
that you want to select.

e Drag the mouse ([}) across the text that you
want to select.

(@ The app highlights the characters to indicate
that they are selected.

© To cancel a selection, click anywhere outside
the text or press any arrow key on your
keyboard.
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